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Back up custom plug-in resources

Back up custom plug-in resources

The backup workflow includes planning, identifying the resources for backup, managing
backup policies, creating resource groups and attaching policies, creating backups, and
monitoring the operations.

The following workflow shows the sequence in which you must perform the backup operation:

Define a backup strategy. ;‘m\l

Add resources.

.

Create a backup policy.

!

If you have multiple resources, create a
resource group, attach policies, and
create an optional schedule.

¥

Back up the resource or resource group.

-

Maonitor the backup operation.

View related backups and clones in
Topology page.

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone operations.
For detailed information about PowerShell cmdlets, use the SnapCenter cmdlet help or see the SnapCenter
Software Cmdlet Reference Guide

Add resources to SnapCenter Custom Plug-ins

You must add the resources that you want to back up or clone. Depending on your
environment, resources might be either database instances or collections that you want
to back up or clone.

Before you begin

* You must have completed tasks such as installing the SnapCenter Server, adding hosts, creating storage
system connections, and adding credentials.
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* You must have created a custom plug-in for your application.

* You must have uploaded the plug-ins to SnapCenter Server.

About this task
You can also add resources for MySQL and DB2 applications.

Steps
1. In the left navigation pane, select Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, select Add Resource.

3. In the Provide Resource Details page, perform the following actions:

For this field... Do this...

Name Enter the name of the resource.

Host name Select the host.

Type Select the type. Type is user defined as per the
plug-in description file. For example, database and
instance.

In case the type selected has a parent, enter the
details of the parent. For example, if the type is
Database and the parent is Instance, enter the
details of the Instance.

Credential name Select Credential or create a new credential.

Mount Paths Enter the mount paths where the resource is
mounted. This is applicable only for a Windows
host.

4. In the Provide Storage Footprint page, select a storage system and choose one or more volumes, LUNSs,
and gtrees, and then select Save.

Optional: Select the * icon to add more volumes, LUNs, and gtrees from other storage systems.

SnapCenter Custom Plug-ins does not support automatic discovery of the resources. The

@ storage details of physical and virtual environments are also not discovered automatically.
You must provide the storage information for physical and virtual environments while
creating the resources.
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5. In the Resource Settings page, provide custom key-value pairs for the resource.
Use the custom key-value pairs if you want to pass resource-specific information. For example, when you
are using the MySQL plug-in, you must specify a HOST as HOST=hostname, PORT =port-no used for

MySQL and master-slave configuration as MASTER_SLAVE = “YES” or “NO” (name is MASTER_SLAVE
and value is “YES” or “NO”).

(D Ensure that the words HOST and PORT are in uppercase.

Resource settings &

Custom key-valie pairs far MyS0L phig-in

TER_SLAVE s | i | o |

6. Review the summary, and then select Finish.

Result

The resources are displayed along with information such as type, host or cluster name, associated resource
groups and policies, and overall status.

@ You must refresh the resources if the databases are renamed outside of SnapCenter.

After you finish

If you want to provide access to the assets to other users, the SnapCenter administrator must assign assets to
those users. This enables users to perform the actions for which they have permissions on the assets that are
assigned to them.

After adding the resources, you can modify the resource details. If a custom plug-in resource has backups



associated with it, the following fields cannot be modified: resource name, resource type, and host name.

Create policies for custom plug-in resources

Before you use SnapCenter to back up custom plug-in specific resources, you must
create a backup policy for the resource or resource group that you want to back up.

Before you begin
* You should have defined your backup strategy.

For details, see the information about defining a data protection strategy for custom plug-ins.
* You should have prepared for data protection.

Preparing for data protection includes tasks such as installing SnapCenter, adding hosts, creating storage
system connections, and adding resources.

» The storage virtual machines (SVMs) should be assigned to you for mirror or vault operations.

The SnapCenter administrator must have assigned the SVMs for both the source and destination volumes
to you if you are replicating Snapshots to a mirror or vault.

* You should have manually added the resources that you want to protect.

About this task

» A backup policy is a set of rules that governs how you manage, schedule, and retain backups. Additionally,
you can specify replication, script, and application settings.

» Specifying options in a policy saves time when you want to reuse the policy for another resource group.
» Snaplock

o If 'Retain the backup copies for a specific number of days' option is selected, then the SnapLock
retention period must be lesser than or equal to the mentioned retention days.

o Specifying a Snapshot locking period prevents deletion of the Snapshots until the retention period
expires. This could lead to retaining a larger number of Snapshots than the count specified in the

policy.

o For ONTAP 9.12.1 and below version, the clones created from the SnapLock Vault Snapshots as part
of restore will inherit the SnapLock Vault expiry time. Storage admin should manually cleanup the
clones post the SnapLock expiry time.

@ Primary SnapLock settings are managed in SnapCenter backup policy and the secondary
SnapLock settings are managed by ONTAP.

Steps
1. In the left navigation pane, click Settings.

2. In the Settings page, click Policies.

3. Click New.

4. In the Name page, enter the policy name and description.
5. In the Settings page, perform the following steps:

o Specify the schedule type by selecting On demand, Hourly, Daily, Weekly, or Monthly.



®

You can specify the schedule (start date, end date, and frequency) for the backup
operation while creating a resource group. This enables you to create resource groups
that share the same policy and backup frequency, but enables you to assign different
backup schedules to each policy.

Schedule freguency
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saving time (DST).

If you have scheduled for 2:00 a.m., the schedule will not be triggered during daylight

> In the Custom backup settings section, provide any specific backup settings that has to be passed to
the plug-in in key-value format. You can provide multiple key-values to be passed to the plug-in.

6. In the Retention page, specify the retention settings for the backup type and the schedule type selected in

the Backup Type page:

If you want to...

Keep a certain number of Snapshots

Then...

Select Total Snapshot copies to keep, and then
specify the number of Snapshots that you want to
keep.

If the number of Snapshots exceeds the specified
number, the Snapshots are deleted with the oldest
copies deleted first.

You must set the retention count to 2
or higher if you plan to enable
SnapVault replication. If you set the
retention count to 1, the retention
operation might fail because the first
Snapshot is the reference Snapshot
for the SnapVault relationship until a
newer Snapshot is replicated to the
target.

®

The maximum retention value is
1018 for resources on ONTAP 9.4 or
later, and 254 for resources on
ONTAP 9.3 or earlier. Backups will
fail if retention is set to a value higher
than what the underlying ONTAP
version supports.



If you want to...

Keep the Snapshots for a certain number of days

Snapshot copy locking period

Then...

Select Keep Snapshot copies for, and then
specify the number of days for which you want to
keep the Snapshots before deleting them.

Select Snapshot locking period, and select days,
months, or years.

SnapLock retention period should be less than 100
years.

7. In the Replication page, specify the replication settings:

For this field...

Update SnapMirror after creating a local
Snapshot copy

Do this...

Select this field to create mirror copies of the
backup sets on another volume (SnapMirror
replication).

If the protection relationship in ONTAP is of type
Mirror and Vault and if you select only this option,
Snapshot created on the primary will not be
transferred to the destination, but will be listed in the
destination. If this Snapshot is selected from the
destination to perform a restore operation, then the
following error message is displayed: Secondary
Location is not available for the selected
vaulted/mirrored backup.

During secondary replication, the SnapLock expiry
time loads the primary SnapLock expiry time.

Clicking the Refresh button in the Topology page
refreshes the secondary and primary SnapLock
expiry time that are retrieved from ONTAP.

See View custom plug-in resource related backups
and clones in the Topology page.



For this field... Do this...

Update SnapVault after creating a local Select this option to perform disk-to-disk backup
Snapshot copy replication (SnapVault backups).

During secondary replication, the SnapLock expiry
time loads the primary SnapLock expiry time.
Clicking the Refresh button in the Topology page
refreshes the secondary and primary SnapLock
expiry time that are retrieved from ONTAP.

When SnapLock is configured only on the
secondary from ONTAP known as SnaplLock Vault,
clicking the Refresh button in the Topology page
refreshes the locking period on the secondary that
is retrieved from ONTAP.

For more information on SnapLock Vault see
Commit Snapshots to WORM on a vault destination

See View custom plug-in resource related backups
and clones in the Topology page.

Secondary policy label Select a Snapshot label.

Depending on the Snapshot label that you select,
ONTAP applies the secondary Snapshot retention
policy that matches the label.

If you have selected Update
SnapMirror after creating a local
Snapshot copy, you can optionally

@ specify the secondary policy label.
However, if you have selected

Update SnapVault after creating a
local Snapshot copy, you should
specify the secondary policy label.

Error retry count Enter the maximum number of replication attempts
that can be allowed before the operation stops.

@ You should configure SnapMirror retention policy in ONTAP for the secondary storage to
avoid reaching the maximum limit of Snapshots on the secondary storage.

8. Review the summary, and then click Finish.

Create resource groups and attach policies in Snapcenter

A resource group is the container to which you must add resources that you want to back
up and protect. It enables you to back up all the data that is associated with a given
application simultaneously. You must also attach one or more policies to the resource



group to define the type of data protection job that you want to perform.

Steps
1. In the left navigation pane, select Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, select New Resource Group.

3. In the Name page, perform the following actions:

For this field... Do this...
Name Enter a name for the resource group.

Note: The resource group name should not exceed
250 characters.

Tags Enter one or more labels that will help you later
search for the resource group.

For example, if you add HR as a tag to multiple
resource groups, you can later find all the resource
groups associated with the HR tag.

Use custom name format for Snapshot copy Select this check box, and enter a custom name
format that you want to use for the Snapshot name.

For example, customtext_resource
group_policy hostname or resource
group_hostname. By default, a timestamp is
appended to the Snapshot name.

4. Optional: In the Resources page, select a host name from the Host drop-down list and the resource type
from the Resource Type drop-down list.

This helps to filter information on the screen.

5. Select the resources from the Available Resources section, and then select the right arrow to move them
to the Selected Resources section.
6. Optional: In the Application Settings page, do the following:

a. Select the Backups arrow to set additional backup options:

Enable consistency group backup and perform the following tasks:

For this field... Do this...
Afford time to wait for Consistency Group Select Urgent, Medium, or Relaxed to specify the
Snapshot operation to complete wait time for Snapshot operation to complete.

Urgent = 5 seconds, Medium = 7 seconds, and
Relaxed = 20 seconds.



For this field... Do this...

Disable WAFL Sync Select this to avoid forcing a WAFL consistency
point.

b. Select the Scripts arrow and enter the pre and post commands for quiesce, Snapshot, and unquiesce
operations. You can also enter the pre commands to be executed before exiting in the event of a
failure.

c. Select the Custom Configurations arrow and enter the custom key-value pairs required for all data
protection operations using this resource.

Parameter Setting Description

ARCHIVE_LOG_ENABLE (Y/N) Enables the archive log
management to delete the
archive logs.

ARCHIVE_LOG_ RETENTION number_of_days Specifies the number of days the

archive logs are retained.

This setting must be equal to or
greater than
NTAP_SNAPSHOT_

RETENTIONS.
ARCHIVE_LOG_DIR change_info_directory/logs Specifies the path to the

directory that contains the

archive logs.
ARCHIVE_LOG_EXT file_extension Specifies the archive log file

extension length.

For example, if the archive log is
log_backup 0 0 0 0.16151855
1942 9 and if the file_extension
value is 5, then the extension of
the log will retain 5 digits, which

is 16151.
ARCHIVE_LOG_RECURSIVE_ (Y/N) Enables the management of
SE ARCH archive logs within

subdirectories.
You should use this parameter if

the archive logs are located
under subdirectories.

d. Select the Snapshot Copy Tool arrow to select the tool to create Snapshots:



If you want... Then...

SnapCenter to use the plug-in for Windows and Select SnapCenter with File System

put the file system into a consistent state before =~ Consistency.

creating a Snapshot. For Linux resources, this

option is not applicable. This option is not applicable for SnapCenter Plug-
in for SAP HANA Database.

SnapCenter to create a storage level Snapshot Select SnapCenter without File System
Consistency.

To enter the command to be executed on the host Select Other, and then enter the command to be
to create Snapshots. executed on the host to create a Snapshot.

7. In the Policies page, perform the following steps:

a. Select one or more policies from the drop-down list.

@ You can also create a policy by selecting

The policies are listed in the Configure schedules for selected policies section.

b

. In the Configure Schedules column, select *

for the policy you want to configure.

c. In the Add schedules for policy policy _name dialog box, configure the schedule and select OK.
Where policy_name is the name of the policy that you have selected.

The configured schedules are listed in the Applied Schedules column. Third party backup schedules
are not supported when they overlap with SnapCenter backup schedules.

8. From the Email preference drop-down list on the Notification page, select the scenarios in which you
want to send the emails.

You must also specify the sender and receiver email addresses, and the subject of the email. The SMTP
server must be configured in Settings > Global Settings.

9. Review the summary, and then select Finish.

Back up individual custom plug-in resources

If an individual custom plug-in resource is not part of any resource group, you can back
up the resource from the Resources page. You can back up the resource on demand, or,
if the resource has a policy attached and a schedule configured, then backups occur
automatically according to the schedule.

Before you begin
* You must have created a backup policy.

* If you want to back up a resource that has a SnapMirror relationship with a secondary storage, the ONTAP
role assigned to the storage user should include the “snapmirror all” privilege. However, if you are using the
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“vsadmin” role, then the “snapmirror all” privilege is not required.

Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, filter resources from the View drop-down list based on resource type.

Click ﬂ and then select the host name and the resource type to filter the resources. You can then click ﬂ
to close the filter pane.

3. Click the resource that you want to back up.

4. In the Resource page, if you want to use a custom name, select the Use custom name format for
Snapshot copy check box , and then enter a custom name format for the Snapshot name.

For example, customtext _policy hostname or resource _hostname. By default, a timestamp is appended to
the Snapshot name.

5. In the Application Settings page, do the following:

a. Click the Backups arrow to set additional backup options:

Enable consistency group backup, if needed, and perform the following tasks:

For this field...

Afford time to wait for Consistency Group
Snapshot operation to complete

Disable WAFL Sync

Do this...

Select Urgent, Medium, or Relaxed to specify the
wait time for Snapshot operation to complete.

Urgent = 5 seconds, Medium = 7 seconds, and
Relaxed = 20 seconds.

Select this to avoid forcing a WAFL consistency
point.

b. Click the Scripts arrow to run pre and post commands for quiesce, Snapshot, and unquiesce
operations. You can also run pre commands before exiting the backup operation.

Prescripts and postscripts are run in the SnapCenter Server.

c. Click the Custom Configurations arrow, and then enter the custom value pairs required for all jobs

using this resource.

d. Click the Snapshot Copy Tool arrow to select the tool to create Snapshots:

If you want...

SnapCenter to take a storage level Snapshot

SnapCenter to use the plug-in for Windows to put
the file system into a consistent state and then
take a Snapshot

Then...

Select SnapCenter without File System
Consistency.

Select SnapCenter with File System
Consistency.

11



If you want... Then...

To enter the command to create a Snapshot Select Other, and then enter the command to
create a Snapshot.

6. In the Policies page, perform the following steps:

a. Select one or more policies from the drop-down list.

@ You can also create a policy by clicking

In the Configure schedules for selected policies section, the selected policies are listed.

b.
Click * inthe Configure Schedules column for the policy for which you want to configure a

schedule.

c. In the Add schedules for policy policy _name dialog box, configure the schedule, and then click OK.
Where, policy _name is the name of the policy that you have selected.
The configured schedules are listed in the Applied Schedules column.

7. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want
to send the emails.

You must also specify the sender and receiver email addresses, and the subject of the email. SMTP must
also be configured in Settings > Global Settings.

8. Review the summary, and then click Finish.
The resources topology page is displayed.

9. Click Back up Now.
10. In the Backup page, perform the following steps:

a. If you have applied multiple policies to the resource, from the Policy drop-down list, select the policy
that you want to use for backup.

If the policy selected for the on-demand backup is associated with a backup schedule, the on-demand
backups will be retained based on the retention settings specified for the schedule type.

b. Click Backup.
11. Monitor the operation progress by clicking Monitor > Jobs.
Back up resource groups of custom plug-in resources

You can back up a resource group on demand from the Resources page. If a resource
group has a policy attached and a schedule configured, then backups occur automatically
according to the schedule.

Before you begin
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* You must have created a resource group with a policy attached.

« If you want to back up a resource that has a SnapMirror relationship to secondary storage, the ONTAP role
assigned to the storage user should include the “snapmirror all” privilege. However, if you are using the
“vsadmin” role, then the “snapmirror all” privilege is not required.

Steps
1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, select Resource Group from the View list.

You can search the resource group either by entering the resource group name in the search box or by
clicking ﬂ and selecting the tag. You can then click ﬂ to close the filter pane.

3. In the Resource Groups page, select the resource group that you want to back up, and then click Back up
Now.
4. In the Backup page, perform the following steps:
a. If you have associated multiple policies with the resource group, from the Policy drop-down list, select
the policy that you want to use for backup.

If the policy selected for the on-demand backup is associated with a backup schedule, the on-demand
backups will be retained based on the retention settings specified for the schedule type.
b. Click Backup.
5. Monitor the operation progress by clicking Monitor > Jobs.
> In MetroCluster configurations, SnapCenter might not be able to detect a protection relationship after a
failover.

Unable to detect SnapMirror or SnapVault relationship after MetroCluster failover

o If you are backing up application data on VMDKSs and the Java heap size for the SnapCenter Plug-in
for VMware vSphere is not large enough, the backup might fail. To increase the Java heap size, locate
the script file /opt/netapp/init_scripts/scvservice. In that script, the do_start method command starts
the SnapCenter VMware plug-in service. Update that command to the following: Java -jar
-Xmx8192M -Xms4096M.

Create a storage system connection and a credential using
PowerShell cmdlets

You must create a storage virtual machine (SVM) connection and a credential before
using PowerShell cmdlets to perform data protection operations.

Before you begin
* You should have prepared the PowerShell environment to execute the PowerShell cmdlets.

* You should have the required permissions in the Infrastructure Admin role to create storage connections.
* You should ensure that the plug-in installations are not in progress.
Host plug-in installations must not be in progress while adding a storage system connection because the

host cache might not be updated and databases status might be displayed in the SnapCenter GUI as “Not
available for backup” or “Not on NetApp storage”.

13
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« Storage system names should be unique.
SnapCenter does not support multiple storage systems with the same name on different clusters. Each

storage system that is supported by SnapCenter should have a unique name and a unique management
LIF IP address.

Steps
1. Initiate a PowerShell connection session by using the Open-SmConnection cmdlet.

This example opens a PowerShell session:
PS C:\> Open-SmConnection

2. Create a new connection to the storage system by using the Add-SmStorageConnection cmdlet.

This example creates a new storage system connection:

PS C:\> Add-SmStorageConnection -Storage test vsl -Protocol Https
-Timeout 60

3. Create a new credential by using the Add-SmCredential cmdlet.

This example creates a new credential named FinanceAdmin with Windows credentials:

PS C:> Add-SmCredential -Name FinanceAdmin -AuthMode Windows
—-Credential sddev\administrator

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Back up resources using PowerShell cmdilets

Backing up a resource includes establishing a connection with the SnapCenter Server,
adding resources, adding a policy, creating a backup resource group, and backing up.

Before you begin

* You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

* You must have added the storage system connection and created a credential.

About this task

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Steps

14
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1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-
SmConnection cmdlet.

Open-smconnection -SMSbaseurl

https:\\snapctr.demo.netapp.com:8146\
The username and password prompt is displayed.

2. Add resources by using the Add-SmResources cmdlet.

This example adds resources:

Add-SmResource -HostName

'10.232.206.248"'" -PluginCode 'DB2'
-ResourceName NONREC1 -ResourceType Database -StorageFootPrint

(@
{"VolumeName"="DB2 NONRECIDB";"LunName"="DBZ2 NONRECIDB";"Vserver"="vserv
er scauto secondary"}) -Instance dbZinstl

3. Create a backup policy by using the Add-SmPolicy cmdlet.

This example creates a new backup policy:

Add-SMPolicy -PolicyName 'db2VolumePolicy'

-PluginPolicyType DB2 -description

-PolicyType

'Backup'
'VolumePolicy'

4. Add a new resource group to SnapCenter by using the Add-SmResourceGroup cmdlet.
This example creates a new resource group with the specified policy and resources:

Add-SmResourceGroup -ResourceGroupName

'Verify ManualBackup DatabaseLevel MultipleVolume unix'

-Resources @ (@
{"Host"="10.232.206.248";"Uid"="db2inst2\NONREC"}, @{"Host"="10.232.206.2
48";"Uid"="db2inst1\NONREC" })

-Policies db2ManualPolicy

5. Initiate a new backup job by using the New-SmBackup cmdlet.

New-SMBackup -DatasetName

Verify ManualBackup DatabaselLevel MultipleVolume unix -Policy
db2ManualPolicy

6. View the status of the backup job by using the Get-SmBackupReport cmdlet.

This example displays a job summary report of all jobs that were run on the specified date:
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PS C:\> Get-SmBackupReport -JobId 351

Output:

BackedUpObjects : {DB1}

FailedObjects : {1}

IsScheduled : False

HasMetadata : False

SmBackupId : 269

SmJobId : 230601

StartDateTime : 10/4/2016 11:20:45 PM
EndDateTime : 10/4/2016 11:21:32 PM
Duration : 00:00:46.2536470
CreatedDateTime : 10/4/2016 11:21:09 PM
Status : Completed
ProtectionGroupName : Verify ASUP Message windows
SmProtectionGroupId : 211

PolicyName : test2

SmPolicyId : 20

BackupName : Verify ASUP Message windows scc54 10-04-
2016 23.20.46.2758

VerificationStatus : NotVerified

VerificationStatuses

SmJobError

BackupType : SCC_BACKUP
CatalogingStatus : NotApplicable
CatalogingStatuses

ReportDataCreatedDateTime

Monitor custom plug-in resources backup operations

You can monitor the progress of different backup operations by using the
SnapCenterJobs page. You might want to check the progress to determine when it is
complete or if there is an issue.

About this task
The following icons appear on the Jobs page and indicate the corresponding state of the operations:

In progress
. Completed successfully
 x Failed

Completed with warnings or could not start due to warnings
* B Queued

e @ Canceled
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Steps
1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.
3. In the Jobs page, perform the following steps:
a. Click ﬂ to filter the list so that only backup operations are listed.

b. Specify the start and end dates.

o

. From the Type drop-down list, select Backup.

o

. From the Status drop-down, select the backup status.

()

. Click Apply to view the operations completed successfully.

4. Select a backup job, and then click Details to view the job details.

Though the backup job status displays , when you click on job details you might see that
some of the child tasks of the backup operation are still in progress or marked with warning
signs.

5. In the Job Details page, click View logs.

The View logs button displays the detailed logs for the selected operation.

Cancel backup operations for custom plug-ins
You can cancel backup operations that are queued.

What you will need

* You must be logged in as the SnapCenter Admin or job owner to cancel operations.

* You can cancel a backup operation from either the Monitor page or the Activity pane.

* You cannot cancel a running backup operation.

* You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the backup operations.
» The Cancel Job button is disabled for operations that cannot be canceled.

* If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued backup operations of other members
while using that role.

Steps

1. Perform one of the following actions:

From the... Action
Monitor page a. In the left navigation pane, click Monitor >
Jobs.

b. Select the operation, and then click Cancel
Job.
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From the... Action

Activity pane a. After initiating the backup operation, click on
the Activity pane to view the five most recent
operations.

b. Select the operation.

c. In the Job Details page, click Cancel Job.

The operation is canceled, and the resource is reverted to the previous state.

View custom plug-in resource related backups and clones
in the Topology page

When you are preparing to back up or clone a resource, you might find it helpful to view a
graphical representation of all backups and clones on the primary and secondary storage.
In the Topology page, you can see all of the backups and clones that are available for the
selected resource or resource group. You can view the details of those backups and
clones, and then select them to perform data protection operations.

About this task

You can review the following icons in the Manage Copies view to determine whether the backups and clones
are available on the primary or secondary storage (Mirror copies or Vault copies).

displays the number of backups and clones that are available on the primary storage.

m (0

displays the number of backups and clones that are mirrored on the secondary storage using
SnapMirror technology.

Clones of a backup of a version-flexible mirror on a mirror-vault type volume are displayed in
the topology view but the mirror backup count in the topology view does not include the
version-flexible backup.

U displays the number of backups and clones that are replicated on the secondary storage using
SnapVault technology.

The number of backups displayed includes the backups deleted from the secondary storage. For example,
if you have created 6 backups using a policy to retain only 4 backups, the number of backups displayed
are 6.

Clones of a backup of a version-flexible mirror on a mirror-vault type volume are displayed in
the topology view but the mirror backup count in the topology view does not include the
version-flexible backup.
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Steps
1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, either select the resource or resource group from the View drop-down list.

3. Select the resource either from the resource details view or from the resource group details view.
If the resource is protected, the topology page of the selected resource is displayed.

4. Review the Summary card to see a summary of the number of backups and clones available on the
primary and secondary storage.

The Summary Card section displays the total number of backups and clones.

Clicking the refresh button starts a query of the storage to display an accurate count.

If SnapLock enabled backup is taken, then clicking the Refresh button refreshes the primary and
secondary SnapLock expiry time retrieved from ONTAP. A weekly schedule also refreshes the primary and
secondary SnapLock expiry time retrieved from ONTAP.

When the application resource is spread across multiple volumes, the SnapLock expiry time for the backup
will be the longest SnapLock expiry time that is set for a Snapshot in a volume. The longest SnapLock
expiry time is retrieved from ONTAP.

After on demand backup, by clicking the Refresh button refreshes the details of backup or clone.

5. In the Manage Copies view, click Backups or Clones from the primary or secondary storage to see details
of a backup or clone.

The details of the backups and clones are displayed in a table format.

6. Select the backup from the table, and then click the data protection icons to perform restore, clone,
rename, and delete operations.

@ You cannot rename or delete backups that are on the secondary storage system.

@ You cannot rename the backups that are on the primary storage system.

7. If you want to delete a clone, then select the clone from the table and click jjj to delete the clone.
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